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Defining Template Needs
Analyze and consider:

End Users ♦ How will the documentation be used (e.g. procedures, training, hardware 
documentation, software documentation, scientific, etc.).

Writers ♦ Who will work on the documents, and what is their skill level.

Source Material ♦ Where will you be getting your information? What format will it be in? 
Remember there are filters for many different applications, e.g., Word and 
WordPerfect, etc.

Numbering Styles ♦ How will pages and chapters be numbered? How will numbers appear in the 
table of contents & index?

Platforms & Fonts ♦ What platforms do your users have, and what fonts do they have available.

Design ♦ How to keep the template as easy to use as possible.
• Types of master pages: _______________________________

_________________________________________________

• Variables and conditional text? _________________________
_________________________________________________

• Style and number of paragraph formats.__________________
_________________________________________________

Dissemination ♦ How will templates and style guides be disseminated?

Exporting &
Distribution

♦ Do the FrameMaker documents need to be exported to different formats?
♦ How will documents be distributed?

• Paper _____________________________________________
− Black & White or Color

• On-line ___________________________________________
− One or more output formats from WebWorks ePublisher Pro
− HTML / XML (native Save As)
− Acrobat
− CD ROM

• Other file type ______________________________________

Translations ♦ Will documents be translated into other languages?

MIF or MML ♦ Would MIF or MML enhance the process?

Customization ♦ Are any customization using the FrameMaker Developer’s Kit needed?



Cross Platform Considerations

Apt Solutions Inc.—FrameMaker 7 Templates Considerations & Checklist  3

File Management ♦ If documentation will be distributed to more than one type of user, or in more 
than one format, how will the files be managed?

− Multiple Templates
− Conditional Text
− Variables
− Or a combination?

Cross Platform Considerations

Fonts Consider what fonts are available:
♦ on the platform
♦ to the other users
♦ for printing and preferred for on-line viewing
♦ for conversion to Acrobat, if appropriate

Platform
Character Sets

Standard character sets differ between platforms.
♦ Use character formats for fonts such as a character format using the Symbol 

or WebDings font to alleviate problems with special characters. Be sure that 
the chosen fonts are available on all platforms. Special characters created 
with keyboard shortcuts may not work correctly across platforms (and may 
even disappear).

♦ Test cross platform appearance of special characters.

Graphics Consider:
♦ Available graphic formats for the FrameMaker documents, and 

FrameMakers import capability (filters).
♦ Formats for export (if saving as XML or HTML).
♦ Will the quality be such that the same graphic can be used for print and 

on-line?
♦ Set standards:

− File formats for import.
− Import technique (by reference or by copying)
− Filenames.
− Whether callouts will be done inside the graphic file or in a 

FrameMaker callout.
− Callout procedures (tags, arrowheads, numbering, etc.).

FileNames Consider:
♦ Platform and Operating System (Set Filename preferences).
♦ Method of distribution (CD-ROM, PDF, HTML/XML, WebWorks).
♦ Define the company’s file and directory naming convention.
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Template Sets
Templates sets will often have multiple templates, including:

♦ Title Page template
♦ Table of Contents template
♦ Chapter template
♦ Appendix template
♦ Index template
♦ Templates for other generated lists
♦ Other specialized templates
♦ You may wish to include a book template to demonstrate the setup of a book. 

The file names can not be modified, however, so writers will have to set up 
books for each project.

Paragraph Tags

Tag Names When naming tags, consider:
♦ Function versus appearance

• Paragraph tags can be named in several ways—according to their 
appearance (Head14pt, Head12pt, Body12pt, Body10pt, Indent1.5, 
Indent2.5) or according to their function (Heading1, Heading2, Body, 
Indent1, Indent2). Whenever possible, try to name tags according to 
function. This makes it easier to have sets of templates that can be 
updated easily by importing formats. It is also easier to move from 
template to template if the same tag names are used for the same 
function even if the appearance of the tags varies.

♦ Existing Template Names
• Is there a company standard for tag names.

♦ Tag names in use in other applications, especially where the documents may 
be converted to FrameMaker documents.

♦ FrameMaker standard tag names for blank documents and other 
FrameMaker template tag names.

♦ Match Paragraph tags to WebWorks ePublisher Styles if using Automapping.
♦ HTML/XML tag names (if the final output will be in HTML/XML format).
♦ Ability to use keyboard shortcuts in tagging.
♦ Industry standards such as used in industry DTDs.

Remember to standardize on tag name conventions, capitalization of tag names, and 
use of an underscore in tag names (FrameMaker allows the use of spaces, but they are 
not recommended).

Note:
If you are creating 
paragraph tags (and 
table and character 
tags) for use with a 
structured FM 
document template 
(tags that will be 
called from the EDD), 
be sure to “work from 
the margins” when 
designing them so that 
FM doesn’t keep 
reminding you that 
you shouldn’t change 
paragraph tags in a 
structured document 
(and so you don’t 
inadvertently do so); 
i.e., first click in the 
margin, then create, or 
if already named, 
select the tag name in 
the designer, set 
properties, and click 
Update All.
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Paragraph Tag
Types

Analyze existing documents and future needs to determine the type of paragraph tags 
needed. Typically, there should be paragraph tags for the following functions:

Unique tags are normally created to control aspects such as levels, justification, 
indents, autonumber formats, etc.

Character Tags
Character tags can be named in several ways: according to their appearance (Bold, 
CourierNew 12pt) or according to their function (Emphasis, Callout). Whenever 
possible, try to name tags according to function. This will make it easier to have sets 
of templates that can be updated easily by importing formats. It is also easier to move 
from template to template if the same tag names are used for the same function even 
if their appearance varies.

Headings Body Paragraphs

Lists (numbered, lettered, bulleted) Indent Levels (for body text, numbered 
lists and bulleted lists)

Cautions, Warnings, Notes Footnotes

Figure and Table Captions Table Cells and Table Headings

Titles & Title Page Paragraphs Chapter Titles & Chapter Title Page 
Paragraphs

Callouts Anchors

Headers and Footers Code Tags

Comments Other Specialized Tags

Typical character tags may include:

Bold Emphasis

SmallCaps Superscript

Subscript Code (monospaced font)

Bullet (if using a special font to get 
special bullet styles)

Colors

Callouts Hyperlinks

Font tags such as Symbol Specialized tags such as command, 
button, and label
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Cross References

Types Try to plan ahead for what formats users may need while creating cross reference 
formats. Analyze existing documents and consider new projects for cross-references. 
Consider the page number scheme when planning and building cross-references.

Typical functions for cross-references include:
♦ References to Headings
♦ References to Figures and Tables

• If the words Table and Figure are a part of the autonumber definitions, 
one cross-reference format for both Figures and Tables may be used by 
using the building block <$paranum> instead of specifying Table 
<$paranumonly> or Figure <$paranumonly>

♦ References to Chapters and Appendixes
♦ Footnote and End Note cross references (often using a Superscript character 

tag in the definition, e.g., <Superscript><$paranum>
♦ Chapter Table of Contents
♦ Spot Cross References
♦ Cross reference to give you a total document page count.
♦ Continued on ... Continued from .... for newsletters
♦ Tables of Contents for newsletters (In This Issue)

Planning Among other things, plan:
♦ How much text and punctuation to include in the cross reference format. 

Lengthy text in cross-references can limit their usefulness. For example, 
(For more information, see Cross References on page 17) vs. See Cross 
References on page 17.

♦ Whether to provide for plurals in cross references. For example
Figures 1 and 2 vs. Figure 1 and Figure 2. (both of these require two cross 
references).

♦ Whether you need to provide for cross references external to the chapter or 
book, that include the manual name or chapter name in addition to internal 
cross references.

♦ Character formats in cross references.
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Pagination & Line Breaks

Controlling Pagination & Line Breaks In The Template

Paragraph Tags Tags that always start at the top of a page, such as a Heading1 can be created. Also, 
special tags that force a page break, but contain no text can be created. There are 
advantages and disadvantages of each approach.

Paragraph
Pagination

Pagination can be controlled by using several of the properties found on the 
Pagination page of the paragraph designer:

♦ Keep with Next (will “go with” the next paragraph)
♦ Keep with Previous (will “pull” the previous paragraph)
♦ Widow/Orphan Lines

It is well worth the time to think carefully about these options for each tag, 
experiment with them and test the settings.

Page Layout
Pagination

The setting under Format > Page Layout > Pagination affects the document’s page 
count. Choices for “before saving and printing” are Delete Empty Pages, Make 
Page Count Even, Make Page Count Odd, and Don’t Change Page Count.

Controlling Page Breaks While Writing

Anchored Frames
& Tables

Under Table > Row Format, the Start Row and Keep With properties can be set. 
These options are used when a table needs to break at a specific row.

Turning Float on for an anchored frame or table (Special > Anchored Frame for a 
graphic or in the Start setting in the Table Designer) controls whether FrameMaker 
will allow an anchored frame or table to float if it will not fit in the same text column 
as the anchor point.

Another way to “adjust” the default pagination is to expand or shrink the white space 
in anchored frames holding graphics—make the anchored frame a little “tighter” on 
the graphics.

Manual
Page Breaks

FrameMaker breaks text automatically based upon settings stored in the document’s 
paragraph formats. Users occasionally find themselves needing or wanting to force 
pagination. Consider how you will control pagination in your templates, and whether 
users will be able to override the paragraph formats to put in manual page breaks.

Users can force a page break by overriding the paragraph format on the Pagination 
page of the paragraph designer and forcing the paragraph to start at the Top of Page, 
Top of Column, Top of Left Page, or Top of Right Page or by using Special > Page 
Break (which has the same effect). Both methods create a format override.

It is worth the time trying to get a template to automatically control pagination. This 
will save much effort and time in the future.
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Other There are probably numerous other ways writers adjust pagination to create good 
looking documents. How much of this is “allowable,” i.e. how important is 
appearance versus the function of the template needs to be decided. Minimize the use 
of the methods shown below if possible.

♦ Changing the paragraph font size.
♦ Change the paragraph line or paragraph spacing properties (leading).
♦ Changing the Paragraph Spread and/or Stretch (can be a negative value).
♦ Changing straddle characteristics (Pagination properties).
♦ Changing the text frame on the body page (at least 53 lashes with a wet 

noodle if you do this!).

Of course, we all know that you can press Shift-Enter at the end of a paragraph to 
cause a line feed and thereby “push” the following paragraph down the page. This 
doesn’t create an override and is useful if you just need to nudge the following 
paragraph down one or two lines until it moves to the next page.

Controlling Line Breaks

Non-breaking
Spaces

To keep words together (such as January 15, 35 mm, page 3, Model 385 
XYZ Corporation) insert a non-breaking or hard space between the words
(Ctrl-space).

♦ Include non-breaking spaces in variables, cross references, and areas where 
page numbers will be shown such as an index to keep the contents together.

♦ Nonbreaking spaces are also useful in autonumbers such as paragraphs for 
Figure Titles, Table Titles etc. For example, by using non-breaking spaces, if 
a figure title is referred to in a cross-reference, the words Figure and the 
following figure number can be kept together. It is also possible to have a 
suppress hyphenation symbol in front of the word Figure.

♦ In indexes, put non-breaking spaces between the entry and the page 
number—change the space character in the SeparatorsIX paragraph on the 
index reference page to a non-breaking space.

Controlling
Hyphenation

Suppress or control hyphenation in any of several ways:
♦ By turning off hyphenation for specified paragraph tags (such as SideHeads 

and Titles) on the Advanced page of the paragraph designer.
♦ For a specified word, specify the hyphenation in the Spelling Checker dialog 

box. (Be sure to re-hyphenate the document after these changes look in the 
Dictionaries button in the spell checker).

♦ By inserting a suppress hyphenation symbol within a word.
− With Windows, use Esc n s
− On Unix, use Esc n s n or Meta Shift hyphen
− On a Macintosh, use Esc n s or Command Option Hyphen
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♦ By inserting a non-breaking hyphen
− With Windows, use Esc hyphen h
− On Unix, use Esc hyphen h or Meta hyphen
− On a Macintosh, use Command ‘

♦ By inserting a discretionary hyphen. FrameMaker will hyphenate a word 
where specified, if necessary.

− With Windows, use Esc hyphen D or Ctrl hyphen
− On Unix, use Esc hyphen D or Ctrl hyphen
− On a Macintosh, use Command hyphen

Soft Returns Users can insert soft returns to control line breaks. This may be disadvantageous for 
several reasons - as the template changes, or if used in headings that will go into 
generated files (the soft return will be expressed in the generated text), etc.!

Text Options The setting under Format > Document > Text Options will affect the line breaks in 
a document. It allows specification of the characters FrameMaker will allow line 
breaks after. Defaults include / \= -. Normally FrameMaker breaks between words, 
but if other characters are specified in this field, FrameMaker will break after them 
if necessary.

Creating a “Mini” Site Dictionary
It’s easy to create a “local” site dictionary for use within a work group. Just follow 
these steps:

♦ Pick a document containing many of the words you want in a site dictionary.
♦ Copy the contents of the file into a new file, so that all unknown words are 

written to that file (otherwise, words that were allowed in the original 
document would not be written to the file).

♦ Open the spelling checker, then click on the Dictionaries button.
♦ Select Write All Unknown Words to File, and specify a filename when 

prompted.
♦ Open the file and observe the words contained in it.
♦ Save the file As Text. In the Save as Text dialog box, click Only between 

Paragraphs, and then click Save.
♦ Follow the instructions in the FrameMaker reference for editing a dictionary, 

and for installing it as a site dictionary (instructions differ by platform).

Other Generated Files
Be creative in the use of generated files. For example, generated files can be used for:

♦ Lists of Tables, Figures, and Warnings
♦ A list of Definitions and of Graphics imported by reference
♦ Lists of Part Numbers or a Script for training materials (list of paragraphs)
♦ A list of unresolved cross-references



Multiple Template Sets

 10 Apt Solutions Inc.—FrameMaker 7 Templates Considerations & Checklist

Multiple Template Sets
If files are going to be used for multiple purposes, including:

♦ Having one document apply to more than one model of a part number,
♦ Having one document set to be used for both printing and on-line 

distribution,
♦ Creating manuals for basic and advanced instruction from one set of 

documents, or
♦ Creating documentation before a product is released or named.

Consider:
• Conditional Text

• Variables

• Multiple Templates—for example:
− Several sets of templates, e.g., one for print and one for

on-line use (except when using WebWorks ePublisher which 
eliminates the need for multiple FrameMaker templates for layout 
purposes)

− Variables templates
− Conditional Text templates

• or a combination of the above

For specialized templates, you may want to include “style sheet” templates in the 
book file for easy use. Use them for importing only, and don’t print them. 

On-Line Template Considerations

The Goal

Write Once,
Publish Many

Today’s organizations have many reasons for using electronic publishing as a vehicle 
for a competitive advantage, or simply to reduce costs and time involved with paper 
documents. On-line documents allow users to receive the most current information 
available, can provide new products and services for customers, reduce costs of 
printing and shipping, allow distribution of knowledge in a common format across 
time, space, and platforms as well as allow for printing on demand versus time and 
money consuming cycles of printing new documentation and shipping.

FrameMaker
Features

FrameMaker make’s this goal much easier than other systems in several key areas:
♦ Built in hypertext, which is converted to on-line formats.
♦ Generated hypertext files such as table of contents and indexes.
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♦ Its database (object) structure including paragraph and character styles.
♦ The ability to import features from one document into another. 
♦ Conditional text.
♦ “Value added” conversions to the widely used on-line viewing formats 

Acrobat PDF and HTML/XML.
♦ Comes with WebWorks Publisher Standard (although serious users will want 

to upgrade to WebWorks ePublisher Pro).
♦ Can create tagged PDFs right from FrameMaker.

Color
Build more color into your template, by using FrameMakers colors or by defining 
custom colors and tints. Color can be used in paragraph tags, character tags, master 
pages, and cross-references. The appearance of color text and graphics printed on a 
black and white printer (greyscale) also adds interest to the page.

Depending upon preferences, printers, and platform options, separate templates for 
printing and for on-line may be desired.

Windows has an option for printing to allow you to “Print Spot Color as Black/White”. 
This may be useful to you. The Macintosh has special options for printing and pre-
press.

Navigation
One important consideration in any template is navigation. There are multiple 
navigation options to choose from, including:

♦ Traditional. “Print” everything to the on-line format and let the user use the 
traditional navigation aids.

♦ On-line enhancements (except for cross-references these are not necessary 
when using WebWorks ePublisher Pro):
• Generated Files such as TOCs

• Cross-references

• Buttons
− Create image maps or include navigation buttons for HTML/XML 

documents.
− Include navigation buttons on the masterpages for Acrobat 

Documents (or just the images, then place the actions from within 
Acrobat). Of course, this can easily be done in Acrobat Pro as well.

♦ Bookmarks (Acrobat)
♦ Cover pages and/or summary TOCs built with cross-references or generated 

files.
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Graphics
Test formats & make decisions related to:

♦ Quality—can the same graphic be used for print and on-line.
♦ How to incorporate graphics associated with paragraphs:

• No change from print (Acrobat)

• When using WebWorks ePublisher Pro, you can do this as part of the 
project (HTML/XML)

♦ Compression options (Acrobat)
♦ Formats for export (HTML/XML)

EPS graphics are indexable & searchable in PDF files, plus generally they are vector 
files.You may have to test output from your graphics programs to achieve this.

Master Pages
Consider the following page design issues:

♦ Should there be more color?
♦ Will navigation buttons be included when converting to PDF?
♦ Is a single-sided layout versus a double-sided layout more desirable when 

going to Acrobat? This probably depends on whether the document will be 
printed or simply viewed online.

♦ Should typical master page items such as titles be moved to the body pages 
when the document is destined for HTML/XML conversion? (Only the 
contents of Flow A are converted to HTML/XML)

Remember, FrameMaker documents can be automatically split into smaller, linked 
web pages when converting to HTML/XML. This can be set at the specified 
paragraph when mapping the FrameMaker paragraph styles to HTML/XML styles or 
can be set directly in a WebWorks ePublisher Pro project.

Generated Files
Consider:

♦ The need for additional files such as cover sheets and explanation or 
introductory documentation.

♦ Removing source page numbers in generated files if the documents are for 
on-line distribution only.
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Additional HTML Considerations

Additional
Decision Areas

In addition to the decision areas noted above for on-line documents, consider:
♦ What conversion tool you plan to use, e.g., WebWorks ePublisher Pro (this 

will have an impact on many of your considerations and your template).
♦ What browser your user is likely to use, and what Browser / Browser 

Version / HTML Version do you want to create for? This will also impact the 
amount of testing you will need to do on the HTML output.

♦ Whether you want to use Cascading Style Sheets (CSS) and whether your 
tool supports them. This will also impact the amount of testing you will need 
to do on the HTML output.

♦ The need for file splitting based on paragraph tags—a big decision area!
♦ Whether to use the FrameMaker TOC and IX or to allow the HTML 

conversion process to create the TOC (the FM TOC and IX is not used in 
ePublisher).

♦ How to get the most value in the source document to reduce work upstream, 
in the process, downstream, and rework.

What is Converted When a document is saved as HTML/XML, FrameMaker converts:
♦ Hypertext in:

• Generated Files - Table of Contents, Index, List of Figures, etc.

• Cross References

• Some additional hypertext commands are supported, such as URLs 
and hypertext commands for graphics (for image maps or buttons)

♦ Macros you define (FrameMaker’s HTML/XML Conversion)
♦ Tables
♦ The contents of the main text flow (Flow A), including graphics in anchored 

frames in the main text flow.
• Graphics and text not in the Flow A—whether they appear on master 

pages (such as headers and footers) or directly on body pages (such as 
graphics placed directly on the page)—are not converted to HTML. 

• Contents of anchored frames in the Flow A are converted to graphics 
(including any text within anchored frames). 

If a document has multiple flows that need to be preserved (for example, a 
newsletter), consider saving as PDF instead. When a document is saved as PDF, 
each flow can be converted to an Acrobat article thread.
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Additional Acrobat Considerations

Template
Considerations

In addition to the decision areas noted above for on-line documents, consider
♦ Fonts, Fonts, Fonts! Among other things, consider

• The appearance of the fonts on-line versus print.
• Availability of fonts on your platforms & printers.
• Fonts the user is likely to have available.
• Fonts that are necessary to embed.

♦ Whether to use a FrameMaker index, or to create a full text search Index with 
Acrobat Catalog, or allow users to use Acrobat’s search function.

♦ How to get the most value in the source document to reduce work upstream, 
in the process, downstream, and rework.

FrameMaker
“Value Add” for

Acrobat

FrameMaker allows the creation of a document with “value added” features built in 
for Acrobat. Use either the Distiller Process, File > Save As, or print directly to the 
Adobe PDF printer (Acrobat 6 and 7) or Acrobat Distiller printer (Acrobat 5).

Value Added Features include:
♦ Hypertext

• Generated Files - Table of Contents, Index, List of Figures, etc.
• Cross References
• Some additional hypertext commands are supported

♦ Bookmarks, Tagged PDFs, Articles, and Notes
♦ Other

PDF files created using the PDFwriter print driver do not preserve these “value 
added” features. PDFWriter is no longer supported by Adobe.

EPS graphics are indexable & searchable in PDF files, plus generally they are vector 
files.You may have to test output from your graphics programs to achieve this.

Enhancing Your Use of FrameMaker

Generated Files It might be desirable to include generated files in FrameMaker books that are used as 
tools for writers instead of as part of the finished product. They can be included in the 
book file after the other files, and either removed when the document is complete, or 
not printed. Examples include:

♦ Lists of Unresolved Cross References (or use as the Book’s error log)
♦ Lists of Referenced Graphics
♦ List of markers
♦ Lists of paragraphs
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Assisting Users Customize the use of FrameMaker by:
♦ Providing Site Dictionaries.
♦ Providing tools such as:

• Graphic libraries and callout symbols.

• Special company or industry specific words that already include 
special characters such as trademark symbols or copyright symbols, 
non-breaking spaces and hyphens, etc.

• A list of symbols commonly used with the character tags applied.
♦ Customizing FrameMaker’s initialization files (e.g., maker.ini.
♦ Customizing menus.
♦ FrameMaker can be customized and utilities created with the FrameMaker 

Developer’s Kit.

Updating Formats in a Document

Importing Formats When formats are imported into a document, same name elements are replaced with 
the new elements. Formats in the document being imported to that have no 
counterparts in the document you are importing from are kept in the document—
resulting in a hybrid document. For this reason, it’s important to delete unneeded 
formats before importing. Formats easily deleted include:

♦ Paragraph Formats
♦ Character Formats
♦ Table Formats
♦ Unused Cross Reference Formats (if you try to delete a cross-reference 

format that is in use, you will be warned, just press Cancel)
♦ Unused Variables (if you try to delete a variable that is in use, you will be 

warned, just press Cancel.)

Copying Contents
into a Template

In reality, it may not be possible to delete/update everything. For this reason, you 
may want to use this procedure:

♦ Open the template.
♦ Save to a new filename.
♦ Open the existing document.
♦ Copy all contents to the new template.
♦ Retag / reformat as necessary. Paragraphs with formats that were used in the 

old document, but are not in the new catalog will show as an override. Retag 
them (or search for them and retag).
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Building the Template - A Checklist
Do some, or all, of these steps depending upon the purpose of the template.

Template Setup ❐ Create a new document (create a blank document from the Custom dialog or use an 
existing document or template to start).

❐ Set up the Right master page (and Left if the document is double-sided).
❐ Add and name any custom master pages.
❐ Determine Pagination scheme (i.e. Continuous or restart for each type of file in the 

book).
❐ Enter background text and graphics on the master pages, including headers and 

footers.
❐ Define the Document Properties (Format > Document) including Numbering, 

Change Bars, Footnote Properties, Text Options, PDF Setup, and Optimize PDF Size.
❐ Define the File Preferences.
❐ Define the View Options.
❐ Create graphic frames for use of reference graphics in paragraphs.
❐ Create reference pages for graphic libraries, if desired.
❐ Create custom colors and tints.
❐ Create the paragraph formats. Delete FrameMakers default formats if they are not 

used.
❐ Create the character formats. Delete FrameMakers default formats if they are not 

used.
❐ Create the table formats. Delete FrameMakers default formats if they are not used.
❐ Define cross-reference formats. Delete FrameMakers default formats if they are not 

used.
❐ Define tags and settings for conditional text. Delete FrameMakers default formats if 

they are not used.
❐ Create user variables, if needed.
❐ Define equation sizes, fonts, and math definitions, if needed.
❐ HTML/XML - Modify and complete the HTML/XML reference pages (Mapping 

Tables) for the book and file if you are going to use Save As to create this output.
❐ Delete any unused or undesirable formats, or formats that were imported from other 

templates that are not wanted.

Additional Steps in
the Process

❐ Create a style guide, i.e., document the template.
❐ Test the template.
❐ User-test the template.
❐ Determine and document the process for revisions of the template and 

documentation.
❐ Distribute the template to users.
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